[bookmark: _Hlk135983707]Word 365 Desktop Edition with SuperNova and Dolphin ScreenReader Hotkey Summary

Details:
Source: https://learn.yourdolphin.com
Published: March, 2024
Supports: SuperNova and Dolphin ScreenReader Version 23.0.

Introduction
This is a free supplementary document available from the Dolphin Learning Zone. It is part of the Microsoft Word 365 Desktop Edition with SuperNova and Dolphin ScreenReader support pages.
This document contains the keyboard commands you use to complete many popular tasks in Word 365, alongside the SuperNova and Dolphin ScreenReader hotkeys that may assist.

Enhance Word with sounds
You can enhance your experience using Word by enabling sounds. When enabled, sounds will reinforce many of the common actions you perform such as deleting, cutting, pasting, and actions like autocorrection, opening task pane, and closing task pane.
When enabled, the sound effects are used in all Microsoft Office apps irrespective of the app you chose to turn them on.
To enable sounds:
1. Open Excel, Outlook, PowerPoint, or Word.
2. Open the "File" menu and select "Options" (ALT + F, T).
3. Select the "Accessibility" category.
4. Select "Provide feedback with sound" check box (ALT + S).
5. TAB to and select a sound scheme. You can choose between two different sound schemes: Modern and Classic.
6. Select the "OK" button.

Hotkey conflicts
[bookmark: _Hlk151035208]You may experience a hotkey conflict with some of the stated keyboard commands. If you are unfamiliar with resolving hotkey conflicts, please visit Resolving hotkey conflicts with Apps.

	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Pass next key to application
	LEFT CONTROL + 7
	CAPS LOCK + 3

	Toggle hotkeys on off
	LEFT CONTROL + 8
	LEFT SHIFT + CAPS LOCK + 3



Open, saving, printing, and closing documents
	Command
	Hotkey

	Create a new document
	CONTROL + N

	Open the "Open" dialog box
	CONTROL + F12

	Open the "Save As" dialog box
	F12

	Save changes to the current document
	CONTROL + S

	Open the "Print" options 
	CONTROL + P

	Switch to next open document
	CONTROL + F6

	Close the current document
	CONTROL + F4 or CONTROL + W

	Close Word
	ALT + F4



Navigating UI elements including Ribbon, Task Pane, and Status Bar
	Command
	Hotkey

	Move focus to next main element
	F6

	Move focus to previous main element
	SHIFT + F6

	Move focus to the Ribbon tab
	ALT or F10

	Move focus to a specific Ribbon tab
	ALT + Ribbon tab key (for example ALT + H to move to the Home tab, ALT + N to move to the Insert tab, etc.

	Open the context menu
	SHIFT + F10 or APPLICATION KEY

	Move focus to the previous group in the Ribbon
	CONTROL + LEFT ARROW

	Move focus to the next group in the ribbon
	CONTROL + RIGHT ARROW

	Explore commands
	Arrow Keys or TAB / SHIFT + TAB

	Move focus to the Quick Search box to enable searching for Ribbon commands
	ALT + Q

	Close Task Pane
	Press F6 to move focus to the Task Pane, then CONTROL + SPACEBAR to open the task pane menu, and select "Close"



[bookmark: _Hlk141869337]Useful SuperNova and Dolphin ScreenReader commands when navigating the Ribbon, Task Pane, and Status Bar
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak focus
	NUMPAD 0
	CAPS LOCK + UP ARROW

	Speak additional focus information, describes help text and shortcut key for current Ribbon command
	LEFT SHIFT + NUMPAD 0
	LEFT CONTROL + CAPS LOCK + UP ARROW

	Speak shortcut key
	LEFT SHIFT + NUMPAD PERIOD
	LEFT CONTROL + CAPS LOCK + LEFT ARROW

	Speak status bar information
	NUMPAD 2
	CAPS LOCK + PAGE DOWN

	List commands in the Quick Access Toolbar
	CAPS LOCK + Q
	CAPS LOCK + Q


[bookmark: _Hlk141437315]
[bookmark: _Hlk141438045]---
Tip: The shortcut key for a Ribbon tab, and the descriptive text for Ribbon commands, are automatically announced when using a High Verbosity Scheme. You can adjust your Speech Verbosity Scheme by pressing CAPS LOCK + EQUALS or, if you are using the Laptop Universal hotkey set, press CAPS LOCK + V.
To change your Braille Verbosity Scheme, press LEFT SHIFT + CAPS LOCK + EQUALS OR, if you are using the Laptop universal Hotkey Set, press LEFT CONTROL + CAPS LOCK + V.
---

Navigating and selecting text commands
	Command
	Hotkey

	Move focus to previous / next character
	LEFT / RIGHT ARROW

	Move focus to previous / next word
	CONTROL + LEFT / RIGHT ARROW

	Move focus to previous / next line
	UP / DOWN ARROW

	Move focus to previous / next paragraph
	CONTROL + UP / DOWN ARROW

	Move focus to start of line
	HOME

	Move focus to end of line
	END

	Select a character
	Position the focus to the left of the character and press SHIFT + RIGHT ARROW

	Select a word
	Position the focus to the left of the word and press CONTROL + RIGHT ARROW

	Select a line
	Position the focus at the start of the line and press SHIFT + DOWN ARROW

	Select a paragraph
	Position the focus at the start of the paragraph and press SHIFT + CONTROL + DOWN ARROW

	Select all
	CONTROL + A

	Enable Selection Mode
	F8

	Extend selection when using Selection Mode
	Arrow Keys

	Extend unit selection such as word, sentence, and paragraph when using Selection Mode
	F8 multiple times

	Cancel Selection Mode
	ESCAPE



[bookmark: _Hlk143073807]Useful SuperNova and Dolphin ScreenReader commands when editing, navigating, and selecting text
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Cycle typing modes
	CAPS LOCK + SEMI COLON
	CAPS LOCK + 2

	Speak character
	NUMPAD 4
	CAPS LOCK + LEFT ARROW

	Speak word
	NUMPAD 5
	CAPS LOCK + RIGHT ARROW

	Speak line
	Numpad 6
	CAPS LOCK + UP ARROW

	Speak line to focus
	Left shift + numpad 1
	CAPS LOCK + HOME

	Speak line from focus
	LEFT SHIFT + NUMPAD 2
	CAPS LOCK + END

	Speak sentence
	CAPS LOCK + NUMPAD 4
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + S

	Speak paragraph
	CAPS LOCK + NUMPAD 5
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + P

	Speak selection
	NUMPAD 1
	LEFT SHIFT + CAPS LOCK + DOWN ARROW

	Read document using Read from here
	NUMPAD PLUS
	CAPS LOCK + DOWN ARROW

	When using Read from here, pause / restart reading
	SPACEBAR
	SPACEBAR

	Exit Read from here
	ESCAPE
	ESCAPE



---
Tip: Speak keys provide additional output when pressed multiple times, for example, pressing the Speak character hotkey twice means the character is spelt phonetically, a third press describes the character’s font attributes, and a fourth press states the character’s Unicode value.
---

Useful SuperNova and Dolphin ScreenReader Quick Navigation keys
Quick Navigation Keys enable you to jump to specific elements in a document. Adding the SHIFT key enables you to jump to the previous element. SuperNova and Dolphin ScreenReader will say "not found" when no matches are located in the direction you are searching.
[bookmark: _Hlk141966699]Popular Quick Navigation Keys
	To do this
	Press

	Move focus to the next heading
	CAPS LOCK + H

	Move focus to the next table
	CAPS LOCK + T

	Move focus to the next graphic
	CAPS LOCK + G

	Move focus to the next link
	CAPS LOCK + K

	Move focus to the next list
	CAPS LOCK + L

	Move focus to the next list item within a list
	CAPS LOCK + I



More Quick Navigation Keys for Word
	To do this
	Press

	Move focus to Bookmark
	CAPS LOCK + A

	Move focus to Comment
	CAPS LOCK + C

	Move focus to Footnote or Endnote
	CAPS LOCK + F

	Move focus to Text Box
	CAPS LOCK + M

	Move focus to Revision
	CAPS LOCK + R

	Move focus to Section break
	CAPS LOCK + Z

	Move focus to next paragraph
	CAPS LOCK + P

	Move focus to next normal style paragraph
	CAPS LOCK + N

	Move focus to next paragraph presented in a different style
	CAPS LOCK + D

	Move focus to next object of any type
	CAPS LOCK + O



Note: SuperNova and Dolphin ScreenReader also include Quick Navigation Keys for Word form elements. These are CAPS LOCK + B for button, CAPS LOCK + E for edit box, and CAPS LOCK + X for check box. However, Word forms have significant accessibility barriers, and it is recommended alternative form types be considered for use. You can learn more by visiting Accessible Digital Documents (external link).

Working with text
Word includes a wealth of keyboard commands that make working with text a productive experience when using the keyboard. In most cases, the stated hotkeys require you to make a selection prior to applying the hotkey.
	Command
	Hotkey

	Change the case of text
	SHIFT + F3. Repeated presses of this hot key will cycle through the separate ways the capital letter style can be applied including uppercase, lowercase, and initial case

	Capitalise all letters
	CONTROL + SHIFT + A

	Insert an optional hyphen
	CONTROL + MINUS

	Insert a non-break hyphen
	CONTROL + SHIFT + MINUS

	Insert a non-break space 
	CONTROL + SHIFT + SPACEBAR

	Insert the current date
	SHIFT + ALT + D

	Insert the current time
	SHIFT + ALT + T

	Insert the copyright symbol
	CONTROL + ALT + C

	Insert the REGISTRATION symbol
	CONTROL + ALT + R

	Insert the trademark symbol
	CONTROL + ALT + t

	Insert a blank equation
	ALT + EQUALS

	Copy text
	CONTROL + C

	Cut text
	CONTROL + X

	Paste text
	CONTROL + V

	Copy text formatting
	CONTROL + SHIFT + C

	Paste text formatting
	CONTROL + SHIFT + V

	Undo
	CONTROL + Z

	Redo
	CONTROL + Y



Formatting text and paragraphs
Word includes keyboard commands that enable you to change the formatting of text quickly and easily from the keyboard.
	Command
	Hotkey

	Make text bold
	CONTROL + B

	Make text italic
	CONTROL + I

	Make text underlined
	CONTROL + U

	Make Text subscript
	CONTROL + EQUALS

	Make text superscript
	CONTROL + SHIFT + EQUALS

	Left align a paragraph
	CONTROL + L

	Centre a paragraph
	CONTROL + E

	Justify a paragraph
	CONTROL + J

	Right align a paragraph
	Control + r

	Single line space a paragraph
	CONTROL + 1

	One-and-a-half-line space a paragraph
	CONTROL + 5

	Double line space a paragraph
	CONTROL + 2

	Full Left align indentation
	CONTROL + M

	Hanging indentation
	CONTROL + T

	Reset paragraph style back to default values
	CONTROL + Q

	Reset character style back to default values
	CONTROL + SPACEBAR



Useful SuperNova and Dolphin ScreenReader commands  for reviewing text formats
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak character attributes
	NUMPAD 4 (on third press)
	CAPS LOCK + LEFT ARROW (on third press)

	Speak additional focus information about paragraph formatting
	LEFT SHIFT + NUMPAD 0
	LEFT CONTROL + CAPS LOCK + UP ARROW



---
Tip: You can automate the announcement of style changes through the "Text Style Announcements" dialog box in the SuperNova and Dolphin ScreenReader Control Panel. You may find this useful when proof-reading a document for formatting changes.
---

Applying popular inbuilt styles
Word includes keyboard commands that enable you to quickly apply its own inbuilt styles to paragraphs. The use of Styles ensures your document has a consistent look and feel when being viewed.
	Command
	Hotkey

	Apply Heading 1 Style to the current paragraph
	CONTROL + ALT + 1

	Apply Heading 2 Style to the current paragraph
	CONTROL + ALT + 2

	Apply Heading 3 Style to the current paragraph
	CONTROL + ALT + 3

	Apply Normal Style to the current paragraph
	CONTROL + SHIFT + N

	Apply List Bullet Style to the current paragraph
	CONTROL + SHIFT + L



Adjusting lists and tables
You can reorder, promote, and demote the order of the bullet and numbered items in a list without the necessity to cut and paste using keyboard commands. You can also use the same keyboard commands to adjust the position of rows in tables.
	Command
	Hotkey

	Move list item or table row up
	SHIFT + ALT + UP ARROW

	Move list item or table row down
	SHIFT + ALT + DOWN ARROW

	Promote list item
	SHIFT + ALT + LEFT ARROW

	Demote list item
	SHIFT + ALT + RIGHT ARROW



Working with tables
As mentioned in the previous section, you can re-order rows in a table by pressing SHIFT + ALT + UP / DOWN ARROW. The following keyboard commands can also be used in tables.
	Command
	Hotkey

	Navigate cell content
	Arrow Keys

	Select content in next cell
	TAB

	Select content in previous cell
	SHIFT + TAB

	Go to first cell in column
	ALT + page up

	Go to last cell in a column
	ALT + PAGE DOWN

	Go to first cell in row
	ALT + HOME

	Go to last cell in row
	ALT + END

	Go to cell above
	CONTROL + ALT + UP ARROW

	Go to cell below
	CONTROL + ALT + DOWN ARROW

	Go to cell left
	CONTROL + ALT + LEFT ARROW

	Go to cell right
	CONTROL + ALT + RIGHT ARROW

	Select entire row
	Position focus at start of row and press SHIFT + ALT + END

	Select entire column
	Position focus at start of column and press SHIFT + ALT + PAGE DOWN

	Delete all content in a table
	Select table and press DELETE

	Delete table
	Select table and press BACKSPACE



Useful SuperNova and Dolphin ScreenReader commands for reading tables
If you are using a Medium or High Verbosity Scheme, and the table is correctly defined as a table with headings in your document (see Table Design tab in the Ribbon), then SuperNova and Dolphin ScreenReader will automatically read row and column headings as you navigate the table.
SuperNova and Dolphin ScreenReader also includes useful Speak keys you can use when working in tables.
	Command
	Desktop NUMPAD Hotkey Set
	Laptop Universal Hotkey Set

	Speak row and column headings
	NUMPAD 3
	SHIFT + CAPS LOCK + LEFT ARROW

	Speak column
	CAPS LOCK + NUMPAD 6
	SHIFT + CAPS LOCK + RIGHT ARROW

	Speak column from current cell
	CAPS LOCK + NUMPAD PERIOD
	SHIFT + CAPS LOCK + PAGE DOWN

	Speak column to current cell
	CAPS LOCK + NUMPAD 3
	SHIFT + CAPS LOCK + PAGE UP

	Speak row
	CAPS LOCK + NUMPAD 0
	SHIFT + CAPS LOCK + UP ARROW

	Speak row from current cell
	CAPS LOCK + NUMPAD 2
	SHIFT + CAPS LOCK + END

	Speak row to current cell
	CAPS LOCK + NUMPAD 1
	SHIFT + CAPS LOCK + HOME



Other useful SuperNova, Dolphin ScreenReader, and Word keyboard commands
Here is a list of assorted commands you may find helpful when working in Word.
	Command
	Hotkey

	Change to Draft View
	CONTROL + ALT + N

	Change to Print Layout View
	CONTROL + ALT + P

	Insert manual page break
	CONTROL + ENTER

	Insert manual column break
	Control + shift + enter

	Toggle Track Changes on off
	CONTROL + SHIFT + E

	Add a comment
	CONTROL + ALT + M

	Post a threaded comment
	CONTROL + ENTER

	Move focus from comment box to document window
	ALT + F12

	Spell check a document
	F7

	Move to next spelling error in document and open context menu
	ALT + F7

	Look up current word in Thesaurus
	SHIFT + F7

	Open the "Find" option
	CONTROL + F

	Open the "Go to" option
	CONTROL + G

	Open the "Replace" option
	CONTROL + H

	Continue your search in the document window with the browse next command
	CONTROL + PAGE DOWN

	Continue your search in the document window with the browse previous command
	CONTROL + PAGE UP

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of links, headings, tables, etc. in the document
	CAPS LOCK + TAB







[image: Dolphin Computer Access logo.]	P.2
image1.png
Q Dolphin
Computer Access




